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. Windows Media Player 2. USB 3. Picture 4. Jump list

. Windows Media Player is application software. It is used to play and organise both audio and
video files on the computer.
. In Windows 10, Pictures folder is used to store images and photos.

. A jump list is a feature that allows you to view recent documents in a program that is pinned
to the taskbar.

1. Pen drive, Memory card and DVD are three removable storage devices.

2. Snap feature of Windows 10 is a feature that arranges the two windows side by side exactly

to fill half of the screen. It is different from Sneak feature as the Sneak feature of Windows
10 shows a preview of the windows that are open on the taskbar.

Snap feature is useful when you have to compare two files. Sneak feature is useful when you
have to restore different windows and search for a particular window.

Right-click on the image file and select Rename option.
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1. Transition determines how your presentation moves from one slide to the next.

. Transition determines how your presentation moves from one slide to the next whereas

Animations help in giving a moving effect to text and other objects on a slide.

1. To add sound to the presentation, follow these steps:

Step 1:
Step 2:
Step 3:

Step 4:

Click on Audio command on the Insert tab. A drop-down list appears.
Select the Audio from file option. The Insert Audio dialog box appears.

Navigate and select the audio file to be inserted and click on Insert button. This
will insert a speaker icon on the slide.

Click on play button to listen to the audio.

. Action buttons are used for navigating from one slide to another. We can also assign a

particular task to do, when the viewer of the presentation clicks on an action button.

In PowerPoint, 12 types of action buttons are available.

3. Steps to add animation in a presentation:

Step 1:
Step 2:
Step 3:

Step 4:

Step 5:

Click on the Animations tab.
You can either open the Animation group or use the drop-down list.

Select the animation effect you would like. There are entrances, exits, emphasis and
paths.

Specify whether you want your animation to start On Click, After previous or With
previous from the Timing group of the Animations tab.

You can preview the effect of animation by selecting Preview command from
Animations tab or Play button in Animation Pane.

I will suggest Rohan to find the Video command in the Insert tab.
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Periodic Assessment 1
(Based on chapters 1 & 2)

1. Record Button is used to record your voice.

2. Video file is used to enhance the understanding of a presentation.

3. Chart is used to display the data in pictorial form.

4. Slide Master is used to create the default layout and appearance of the slide in the presentation.

1. Ajump list is a feature that allows you to view recent documents in a program that is pinned
to the taskbar.

2. Sneak feature of Windows 10 shows a preview of the windows that are open on the taskbar.
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. Organize menu 2. Share with menu

. E-mail option 4. Slide show option

Formulas and Functions

l EXERCISE @’
A. lc 2.a 3.b 4. c 5.c¢
B. 1. Functions 2. Equal to 3. Square root 4. Dollar ($)
C. 1. Acell reference is a cell address that can be used in a formula to denote a specific cell.
2. CONCATENATE () function joins together two or more different text strings.
3. Date and Time functions are used to return date, month, day, year and time.
DAY(TODAY()) and MINUTE(time) are the types of Date and Time functions.
D. 1. The LEN function is used to return the length of the text string.
For example, Input=LEN("Excel”), it will return 5.
2. Rules to enter a function are:
(i) All Excel functions must begin with = sign.
(ii) Function name must be a valid Excel name.
(iii) Function must be followed by opening and closing parenthesis.
(iv) Most of the Functions must contain an argument within it.
3. A formula is an expression which calculates the value of a cell. Formulas in Microsoft Excel
begin with an equal sign (=). For example,
=10+20/5 + (5*4)
=20 +60*10
On other hand, functions are predefined formulas in Excel to perform both simple and complex
calculations.
E. She should use cell reference to keep the spreadsheet updated.
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4. Introduction to GIMP

t
A

1.
. Workspace 2. GIMP 3. Layer effect 4. Layers palette
. Patterns 6. Fill with
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EXERCISE @,
b 2.¢C 3.a 4. a

. GIMP has user friendly interface.
. Template represents image types that are commonly useful.
. Menu bar, Toolbox and Layers palette.

. To save a file, follow the given steps:

Step 1. Click on File menu.

Step 2: Click on Save option.

Step 3: Navigate the folder to save the file.

Step 4:  Given the name of the file in the Name: box.

Step 5: Click on Save button.

. To open an image, follow the given steps:

Step 1:  Click on the File menu.
Step 2: Click on the Open option.
Step 3: Choose the image to be inserted.

Step 4: Click on the Open button.

. The Create a New Image dialog box provides the following options:

Template: It represents image types that are commonly useful. The template sets values
for the size, resolution, comments, etc.

Image Size: It specifies the width and height of the new document in pixels, centimeters,
inches, points, millimetres, etc.
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Periodic Assessment 2
(Based on chapters 3 & 4)

A. 1. Cell reference
2. ROUND(number, number_of_digits)
3. Statistical functions
4. MIN(range)
5. LEN(text)

B. Ruler
Menu bar
Toolbox
Foreground/
Background
color
Tools
options
C. 1 Template 2.Image Size 3. Portrait/Landscape button
Test Sheet 1
(Based on chapters 1 to 4)
Section A
A. 1. (i) 2.(i) 3.(3) 4. (i)
6. (ii) 7. (iii) 8. (i)
B. 1. Windows Media Player 2. Text 3. Square Root
4. Layers palette 5. Patterns
C. LF 2.F 3T 4.7
5T 6. F

Brushes/
Pattern/Fonts
tabs

Layers
palette

4.XandY resolution

5. ()
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Section B
A. 1. Windows Media Player is application software. It is used to play and organise both audio and
video files on the computer.
2. Template represents image types that are commonly useful.
3. (This question was printed incorrectly in the book, please correct it in your textbook)
Q. Give one difference between slide transition and animation.

Ans. Transition determines how your presentation moves from one slide to the next whereas
Animations help in giving a moving effect to text and other objects on a slide.

4. A cell reference is a cell address that can be used in a formula to denote a specific cell.
5. CONCATENATE () function joins together two or more different text strings.

B. 1.The LEN function is used to returns the length of the text string.

For example, Input=LEN("Excel”), it will return 5.

2. Action buttons are used for navigating from one slide to another. We can also assign a
particular task to do, when the viewer of the presentation clicks on an action button.
In PowerPoint, 12 types of action buttons are available.

3. The Create a New Image dialog box provides the following options:
Template: It represents image types that are commonly useful. The template sets values
for the size, resolution, comments, etc.

Image Size: It specifies the width and height of the new document in pixels, centimeters,
inches, points, millimetres, etc.

4. Pen drive, Memory card and DVD are three removable storage devices.
5. To save a file, follow the given steps:
Step 1. Click on File menu.

Step 2: Click on Save option.
Step 3: Navigate the folder to save the file.
Step 4: Given the name of the file in the Name: box.

Step 5: Click on Save button.

5. Services on Internet

I EXERCISE @;’

A. 1b 2.a 3.b 4. a
B. 1T 2.T 3.F 4.7
C. 1. Carding 2. Blogs 3. Chat
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D. 1. Phreakingis a crime committed against telephone companies by using computers with the
goal of making free distance calls or tapping phone lines.

2. A newsgroup focuses on a particular topic. The topic is of general interest of all the participants
to the newsgroup.

3. Cloud storage is a service where the users are able to store and manage data on remote
server in place of their local computer.

E. 1. Steps to upload a file on Google Drive:

Step 1: Visit www.google.com. Click on the Google App Launcher button at the
top-right corner. Click on the Drive app.

Step 2:  Enter your Gmail account’'s username and then click on Next button. Enter
password and then click on Next button.

Step 3: Click on the New button.
Step 4: Click on File Upload to upload and store the file on the remote server.

2. Blogs are generally like a detailed explanation on a subject or sometimes also as a Diary of
Events. It is a discussion platform where the readers of the blog can add their comments and
suggestions. While blogging, you must keep in mind that your posts must not hurt feelings
and reputation of others. Some of the popular websites which allow you to create blogs are
Blogger, Wordpress, Tumbilr, etc.

3. Steps to register on Skype:

Step 1: Double click on Skype icon to start Skype.

Step 2: Click on Sign in or Create button to create an account on Skype. The Sign in
screen appears.

Step 3: Click on Create one! link. The Create account screen appears.

Step 4:  Enter your email and click on Next button.

Step 5: Enter a password and click on Next button.

Step 6: The Skype asks you about your personal details such as your name and it also

asks to upload your photo. Then, click on Continue button.

F. He should use cloud storage service.
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6. App Development
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EXERCISE @;’

a 2.a 3.a 4. b
F 2.T 3.F 4.7 5T

. Hybrid 2. Mobile 3. Android 4. Gaming 5. Install

. An app is a software program primarily developed for hand-held smart devices such as mobile

and tablet.

. Web apps are actually web applications which give a user experience similar to native apps.

We need an extra app called browser to access these apps on our mobile device.

. Three components of Block Editor Window are:

a. Workspace: It arranges all the blocks for coding in the workspace.
b. Trash: It is used for deleting blocks that are not required.

c. Backpack: It stores the copy of all the blocks even when we exit App Inventor.

. a. Gaming Apps- Today’s most popular category of mobile apps is gaming apps which shared

more than 24% area of the app store. The most commonly used gaming apps are PUBG,
Candy Crush Saga, and Angry Birds.

b. Productivity apps, also known as business apps used by businessmen to perform several
complex tasks. The most commonly used productive apps are Google Calendar, Evernote
and Dropbox.

c. Entertainment apps are developed to entertain the people. The most commonly used
entertainment apps are Netflix, Plus Hotstar and YouTube.

. To change the display name, follow the given steps:

Step 1 Click on the button in the View pane.

Step 2 Type a new name for button in the Text box.

. The difference between web app and website is that a web app can be a small part of a

website which provides a particular functionality. On the other hand, a website can contain
many web apps.

. Educational apps provide a platform for children to learn from anywhere and anytime. These

apps use advance methodologies and new concepts to make the learning easier. The most
commonly used educational apps are Khan Academy, Vedantu, and Grammar EN.

. Gaming

. Music Player
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7. Introduction to HTML5 and CSS3

nw > g

EXERCISE ()
.a 2.b 3.a 4.b
. Markup 2. Head 3. Block 4. Empty 5. Nesting

. HTML stands for Hypertext Markup Language. It is a markup language that describes the

structure of the web page.

. The tags that include both opening and closing tags are called Container Tags.
3. CSS handles and describes how a HTML web page will be presented on a web browser.

. The <Head> tag defines header area of your web page. The information given in <Head >

tag tells the computer that this information is not to be shown on the web page.

. In external stylesheet, the CSS styles are written in a separate file which is saved with .css

extension. You need to include a reference to the external style sheet file within the <LINK>
element inside the <HEAD> element. Syntax to include the reference of external stylesheet is:

<head>
<link rel="stylesheet" type="text/css" href="name of style sheet">

</head>

. The rules for writing HTML tags are:

* Container tags should always be closed properly.

* Values given to the attributes should be enclosed within the double quotes.
* Tag name should not contain spaces.

* There should be no spaces between < and > in a tag.

* Tags must be nested correctly.

. HTML editors are software which are used to write and edit HTML codes. There are mainly

two types of HTML editors, WYSIWYG editor and Text Editor. The most commonly used HTML
editors are Notepad and Notepad++.

. An inline style is used to apply a unique style for a single element. The style attribute an

element allows you to create and apply a style on the element. Syntax to create an inline
style is:

<element style = "propertyl:valuel; property2:value2; .. ...">

. Ajit can use heading tags <H1> to <H6>.

. Anjali can use <TITLE> tag.
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F.  (This question was printed incorrectly in the book, please correct it in your textbook)
Q. Solve the crossword using the given clues.

Down:

1. The tags which have only opening tag

2. Most commonly used Text Editor for web page designing

3. Piece of ordinary text that has feature of linking to other documents

6. Attribute used to change background colour 1 2
of a web page

Across: 3(H M 4 ©

3. Markup language used to create web pages

4. Tag used to define the text to be shown on 50T T E
the web page

5. Tag used to define what is to be shown on 7( A
title bar when the web page is opened in
web browser 8 E

7. Attribute used to align heading or text in a
paragraph

8. Tag used to define header area of the web
page

Ans.
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Periodic Assessment 3
(Based on chapters 5 to 7)

A. 1. Blogs are generally like a detailed explanation on a subject or sometimes also as a diary of
events.

2. Cloud storage is a service where the users are able to store and manage data on remote
server in place of their local computer.

3. The process of protecting computer resources such as networks, devices, programs, and data
from unauthorised access, damage, or attack is called cyber security.

4. Hacking is the unauthorised access to computer system for the purpose of destroying the
system or stealing important information from the system.

. Google Play Store
.i0S
. Hybrid app

1
2
3
4. Gaming app
5. Educational app
6

. Social networking apps

C. TITLE </HEAD> </HTML>

8. Introduction to Programming Python

| EXERCISE ®
A. 1b 2.a 3.c 4. a 5.c
B. 1T 2.T 3.F 4.7
C. 1. Guido van Rossum 2. Assignment 3. String
4. Input() 5. False

D. 1. Variables are memory reference points where we store values which can be accessed or
changed later.

2. A data type specifies the type of value a variable can contains.

3. A low-level language is a programming language that is machine dependent. A program
written in machine dependent language runs only on one particular type of computer.
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E. 1. Following are the relational operators provided by Python:
== Equal
I= Not equal
> Greater than
< Less than
>= Greater than or equal to
<= Less than or equal to
For example, == operator: It checks if the values of two operands are equal or not. If yes,
then the condition becomes true.

. Comments in Python can be used to explain parts of the code. It can also be used to hide the
code as well. Comments enable us to understand the way a program works. In python, any
statement starting with # symbol is known as a comment. There are two types of comments
in python:

a. Single Line Comment: In case, a user wants to specify a single line comment, then comment
must start with the symbol #.

b. Multiple-line Comment: Python does not have a syntax for multiline comments. To add a
multiple line comment, you could insert a # for each line.

. High-level language is a programming language that enables a programmer to write programs
that are machine independent.

In third generation languages (3GL), the programmer writes a series of English like words
that tell the computer what to accomplish and how to do. Examples of 3GL are C, C++ and
Java.
The fourth generation languages also use English like statements. They specify what the
program should accomplish without explaining how. A 4GL is fast and requires less time and
effort on the part of the programmer. Examples of 4GL are SQL, Perl, Python, etc.

F. She should use Run Module option in the Run tab of the Menu bar.

G. 120 2.12

..................................... INTHELAB /.

Do yourself.

N

N
12 { Play (Ver. 2.0)-VI (Answer Key)

LA



9. Introduction to Al

(
A.
B
C
D

EXERCISE ()
1.d 2.d 3.b
.Interpersonal 2. Intelligence 3. Howard
T 2.F 3.7

. Bodily-Kinesthetic Intelligence is being good at dancing and sports along with love creating

things with their hands, tends to remember by doing, rather than hearing and seeing, and
excellent hand-eye and physical coordination, flexible in different body movements and
performing actions.

. Alis the branch of computer science that focuses on developing machines which can think

and work like human beings.

. Four uses of Al are:

a. It can automate the repetitive complex tasks.
b. It can predict movies/TV shows/songs/products as per your choice with most accuracy.
c. It can diagnose diseases more effectively than doctor.

d. It can mimic human voice and understands context.

. Intelligence refers to the ability to think, to learn from previous experience, to solve complex

problems and to adapt new things and environment.
Various types of intelligence are-

a. Naturalistic Intelligence

b. Interpersonal Intelligence

¢. Musical Intelligence

d. Existential Intelligence

e. Bodily-kinesthetic Intelligence

f. Linguistic Intelligence

g. Intrapersonal Intelligence

h. Spatial Intelligence

i. Logical-Mathematical Intelligence
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3.a Interpersonal Intelligence Intrapersonal Intelligence
i. Good at communicating ideas and thoughts | i. Canrecognise their strengths and weaknesses
ii. Aware of their own emotional state and
ii. Good at non-verbal communication feelings and know how they can motivate
themselves
dii. Have a different perspective on everything | iii. Enjoy analysing theories and ideas
_/
e D
b. Existential Intelligence Musical Intelligence
i. Look at things from different point of view. | i. Love singing and playing musical instruments
ii. Make connections between what is being | ii. Good at thinking in patterns, rhythms and
learned and the world outside. sounds
I, e s e el i LA S el g iii. Recognise musical patterns and tones easil
L not just of the universe, but of the self. ’ 9 P y
J

F. 1. Naturalistic Intelligence

G. 1.82 2.141

2. Interpersonal Intelligence
3. Plant. Spatial Intelligence is being used here.

H. Visual-Spatial Intelligence is being used here.

..................................... INTHELAB .
Do yourself.
] ]
Periodic Assessment 4
(Based on chapters 8 &9)
A. 1. Existential Intelligent people look at things from different point of view, they make connections

between what is being learned and the world outside and they have a deep and comprehensive
understanding not just of the universe, but of the self.

2. Naturalistic Intelligent people are nature lovers, they love exploring the environment and
learning about other species and enjoy camping, gardening, hiking and exploring outdoors.
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1 = int (input ('"Enter the length of a Rectangle: '))

b = int (input ('Enter the breadth of a Rectangle: "))

area = 1 * Db
print ("Area of a Rectangle is: ",area)
C. 1. Error:Inline 1, comma after variable q
2. Error: In line 3, var3 name and in line 4, plus sign after varl.
Test Sheet 2
(Based on chapters 5 to 9)
Section A
A. 1. (i) 2.(i) 3. (ii) 4. (iii)
5. (This question was printed incorrectly in the book, please correct it in your textbook)
Q. Which quality do people with visual-spatial intelligence possess?
(i) Explaining things well (i)  Good at problem-solving
(iii) Botha.and b (iv) Recognising patterns easily
Ans. (iv)
6. (ii) 7. (ii) 8. (i) 9. (i) 10. (i)
B. 1. Interpersonal 2. Assignment 3. Block 4. Install
5. Carding 6. False
C. 1T 2.T 3.7 4.7
Section B
A. 1. Variables are memory reference points where we store values which can be accessed or

changed later.

2. A low-level language is a programming language that is machine dependent. A program
written in machine dependent language runs only on one particular type of computer.

3. The tags that include both opening and closing tags are called Container Tags.

4. Web apps are actually web applications which give a user experience similar to native apps.

5. Hacking is the unauthorised access to computer system for the purpose of destroying the
system or stealing important information from the system.
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1. Steps to upload a file on Google Drive:

Step 1:  Visit www.google.com.

Step 2:  Click on the Google App Launcher button at the top-right corner. A list of Google
apps appears.

Step 3: Click on the Drive app. The Google's Sign in page appears.

Step 4:  Enter your Gmail account’s username and then click on Next button.

Step 5: Enter password and then click on Next button. This will open your Google Drive
web page.
Step 6: Click on the New button.

Step 7: Click on Upload Folders to upload and store the entire folder on the remote
server.

.i. Gaming Apps- Today's most popular category of mobile apps is gaming apps which

share more than 24% area of the app store. The most commonly used gaming apps are
PUBG, Candy Crush Saga, and Angry Birds.

ii. Productivity apps- These apps also known as business apps used by businessmen to
perform several complex tasks. The most commonly used productive apps are Google
Calendar, Evernote and Dropbox.

iii. Entertainment apps- These apps are developed to entertain the people. The most
commonly used entertainment apps are Netflix, Disney Plus Hotstar and YouTube.

. An inline style is used to apply a unique style for a single element. The style attribute an

element allows you to create and apply a style on the element. Syntax to create an inline
style is:

<element style = "propertyl:valuel; property2:value2; .. ...">

. Comments in Python can be used to explain parts of the code. It can also be used to hide the

code as well. Comments enable us to understand the way a program works. In python, any
statement starting with # symbol is known as a comment. There are two types of comments
in Python:

1. Single Line Comment: In case, a user wants to specify a single line comment, then comment
must start with the symbol #.

2. Multiple-line Comment: Python does not have a syntax for multiline comments. To add a
multiple line comment, you could insert a # for each line.

. Linguistic Intelligent people are good at using words, can remember written and spoken

information, love reading and writing, are good debaters, can explain things well and use
humour while telling stories.
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